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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce
chapitre. Pour une liste plus détaillée, voyez dans 'Aide.

Windows/Linux Equivalent Mac Effet

Sélection de menu LibreOffice > Préférences Acces aux options de paramétrage
Outils > Options

Clic droit F+clic Ouvre un menu contextuel
Ctrl (Contréle) 3 (Commande) Utilisé avec d'autres touches
F5 Maj+38+F5 Ouvre le Navigateur

F11 F+T Ouvre la fenétre Styles & Formatage
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Qu'est-ce qu'un modéle ?

Un modéle est un gabarit que vous utilisez pour créer d'autres documents. Par exemple, vous
pouvez créer un modéle pour des factures qui ont le logo et I'adresse de votre société en haut de
la page. Les nouveaux classeurs créés d'aprés ce modele auront le logo et I'adresse de votre
société sur la premiére page.

Les modéles peuvent contenir tout ce que les documents ordinaires peuvent contenir, comme du
texte, des dessins, des styles et des informations de paramétrage personnalisées comme les
unités de mesure, la langue, l'imprimante par défaut et la personnalisation des barres d'outils et
des menus.

Tous les documents dans LibreOffice sont basés sur les modéles. Vous pouvez créer, ou
télécharger et installer, autant de modéles que vous souhaitez. Si vous ne spécifiez pas de modeéle
quand vous créez un nouveau classeur, ce nouveau classeur sera basé sur le modéle par défaut
pour les classeurs. Si vous n'avez pas spécifié un modeéle par défaut, LibreOffice utilise le modéle
vide pour classeur qui est installé avec le programme. Voir “Définir un modeéle par défaut” page 20.

Que sont les styles ?

Un style est un ensemble de formatages que vous pouvez appliquer a des éléments sélectionnés
dans un document dans le but de changer rapidement leur apparence. Quand vous appliquez un
style, vous appliquez tout un ensemble de formatages en méme temps.

Beaucoup de personnes formatent manuellement les cellules et les pages des classeurs sans faire
attention aux styles. Elles ont I'habitude de formater les documents selon leurs attributs physiques.
Par exemple, pour le contenu d'une cellule, vous pouvez spécifier la police, sa taille et d'autres
formatages comme le gras et l'italique.

Les styles sont des attributs logiques. Utiliser des styles signifie que vous arrétez de dire “taille de
police 14pt, Times New Roman, gras, centré”, et que vous commencez a dire “Titre” parce que
vous avez défini que le style “Titre” a ces caractéristiques. En d'autres termes, les styles signifient
gue vous focalisez votre attention non plus sur ce a quoi le texte (ou la page, ou un autre élément)
ressemble, mais sur ce que le texte est.

Les styles aident a améliorer la cohérence dans un document et peuvent accélérer
considérablement le formatage. lIs facilitent aussi les changements de formatage importants. Par
exemple, vous pouvez décider de changer l'apparence de tous les sous-totaux de votre classeur,
gu'elle soit Arial 10 pt au lieu de Times New Roman 8 pt, aprés que vous avez créé un classeur de
15 pages ; vous pouvez changer tous les sous-totaux d'un document en changeant simplement les
propriétés du style sous-total.

Les styles de page aident a l'impression, vous n'avez alors plus besoin de définir les marges, les
en-tétes et pieds de page et les autres attributs d'impression chaque fois que vous imprimez un
classeur.

Types de styles dans Calc

Alors que d'autres composants de LibreOffice comportent plusieurs types de styles, Calc en a
seulement deux :

* Les styles de cellule comprennent les polices, I'alignement, les bordures, l'arriere-plan, les
formats de nombres (par exemple, monétaire, date, nombre) et la protection des cellules.

* Les styles de page comprennent les marges, les en-tétes et pieds de page, les bordures et
les arriere-plans, et la séquence d'impression des feuilles. Les attributs d'un style de page
s'appliquent seulement quand un classeur est imprimé ; ils ne sont pas affichés a I'écran.
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Styles de cellule

Similaires aux styles de paragraphe dans LibreOffice Writer, les styles de cellule sont le type de
style le plus basique dans Calc. Vous pouvez appliquer un style de cellule a une cellule et cette
derniére suivra les régles de formatage de ce style. Plusieurs styles de cellule sont fournis avec
LibreOffice ; cing sont présentés Figure 1.

Initialement, les styles sont configurés de telle maniere que si vous changez la police Par défaut,
tous les autres styles se modifieront en conséquence. Nous discuterons sur la facon de paramétrer
ceci dans “Créer de nouveaux styles (personnalisés)” page 12.

A |

Titre1 — Styfe de cellule -

Par dafaut — Style de cellule

2 | Titre — Style de cellule
3 |Resultat — Style de cellule
4 |Résultat? — Style de cellule

Fiéure 1 : Types de styles de cellule de Calc

Styles de page

Les styles de page dans Calc sont appliqués aux feuilles. Bien qu'une feuille puisse étre imprimée
sur plusieurs pages (morceaux de papier), un seul style de page peut étre appliqué a une feuille.
Si un classeur comprend plus d'une feuille, les différentes feuilles peuvent avoir différents styles de
page qui leur sont appliqués. Ainsi, par exemple, un classeur peut contenir une feuille a imprimer
en paysage (en modifiant le style de page Par défaut) et une autre feuille & imprimer en portrait (en
utilisant le style de page Rapport par exemple).

Deux styles de page sont fournis avec Calc : Par défaut et Rapport. Vous pouvez ajuster plusieurs
paramétres en utilisant les styles de page. Vous pouvez également définir autant de styles de page
gue vous voulez.

Parce que les classeurs sont d'abord utilisés a I'écran et non imprimés, Calc n'affiche pas le style
de page a I'écran. Si vous voulez qu'un classeur tienne dans une certaine taille de page, vous
devez contrbler soigneusement les largeurs de colonnes et les hauteurs de lignes, avec Fichier >
Apercu et Affichage > Apercu des sauts de page pour vous guider.

Malgré cette limitation, il est intéressant de définir des styles de page pour tous les classeurs que
vous aurez probablement a imprimer. Sinon, lorsqu'un besoin d'impression apparait, vous pouvez
perdre du temps a faire des essais et commettre des erreurs.
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Accéder aux styles

La principale fagon d'accéder aux styles est a travers la fenétre Styles et formatage (Figure 2).
Vous pouvez ouvrir cette fenétre de plusieurs maniéres.

* Clavier : Appuyez sur la touche F11.
* Menu : Choisissez Format > Styles et formatage.

&

La fenétre Styles et formatage peut étre ancrée a gauche ou a droite de la fenétre principale de
Calc. Pour ancrer ou rendre flottante la fenétre, soit gardez appuyée la touche Ctrl et double-
cliguez dans la partie grise prés des icbnes du sommet, soit cliquez n'importe ou dans cette
fenétre puis faites Ctrl+Maj+F10.

e Barre d'outils : Cliquez sur l'icdne tout a gauche de la barre d'outils Formatage.

Le premier bouton en haut a gauche de la fenétre, ‘ affiche les styles de cellule et le

deuxiéme, @ , les styles de page.

Styles et formatage =]

& ¥ ﬂlffaﬁulltLIE“SE”E shyle

LI

e

Styles de cellule

dEfauy ~._ MNouveau style a
Styles de page —| |Résultat partir de la sélection
Résultat2
Titre
Titrel \Mnde Tout remplir
Tous les styles |Z|

Figure 2 : Fenétre Styles et formatage

Appliquer les styles de cellule

Calc fournit plusieurs manieres pour appliquer les styles de cellule :
e Utiliser la fenétre Styles et formatage
e Utiliser le mode Tout remplir
e Utiliser la liste Appliquer le style
* Assigner des styles a des raccourcis clavier

Utiliser la fenétre Styles et formatage

1) Assurez-vous que la fenétre Styles et formatage est ouverte en appuyant sur F11 ou en
sélectionnant Format > Styles et formatage. Choisissez la liste Styles de cellule en

, . LEiz)
cliguant sur l'icbne I'—',

2) Mettez en surbrillance la cellule ou le groupe de cellules auquel le style doit étre appliqué.
3) Double-cliquez sur le nom du style de cellule.

Appliquer les styles de cellule



Utiliser le mode Tout remplir

Cette méthode est utile si vous voulez appliquer le méme style a plusieurs cellules dispersées.
1) Ouvrez la fenétre Styles et formatage et sélectionnez le style que vous voulez appliquer.

2) Cliquez sur l'icbne Mode Tout remplir & . Le pointeur de la souris se présente alors sous
la forme d'une verseuse.

3) Positionnez ce curseur dans la cellule a modifier et cliquez sur le bouton de la souris.

4) Pour quitter le mode Tout remplir, cliquez a nouveau sur l'icone Mode Tout remplir ou
fermez la fenétre Styles et formatage.

Attention Quand ce mode est actif, un clic droit n'importe ou dans le document annule la
A derniére action Tout remplir. Faites attention de ne pas faire un clic droit
/ malencontreusement et ainsi annuler des actions que vous vouliez conserver.

Utiliser la liste Appliquer le style

Vous pouvez ajouter une liste déroulante Appliquer le style a la barre d'outils Formatage, si ce
n'est pas déja fait, et sélectionner un style dans la liste pour l'appliquer aux cellules sélectionnées.

Eichier Egiti::un Affichage Insertion Format Outils Données  Fenétre
B-EB0= BESR T8 KB
© [@ Par défaut @ Arial (] 10 [+]
Al4 |E| ﬂﬁppliquerlelstqu

__d 8B | ¢ | D | E

Fig}ure 3 : Emplacement de la liste Appliquer le style

Assigner des styles a des raccourcis clavier

Vous pouvez créer des raccourcis clavier pour appliquer des styles de cellule ou de page
couramment utilisés, y compris les styles personnalisés que vous avez créés. Voir Chapitre 14
(Paramétrer et Personnaliser Calc) pour le faire.

Appliquer les styles de page

1) Sélectionnez la ou les feuilles a modifier (cliquez sur les onglets en bas de I'écran).
2) Dans la fenétre Styles et formatage, choisissez la liste Styles de page en cliquant sur

l'icbne @ . Double-cliquez sur le style de page voulu.
Pour savoir quel style de page est utilisé pour la feuille sélectionnée, regardez dans la barre d'état.

30
21

Feuillel / 4+ || « m
Feuille1 /1

Figure 4 : Barre d'état avec indication du style de page utilisé sous les onglets
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Modifier les styles

Pour modifier un style, faites un clic droit sur son nom dans la fenétre Styles et formatage et
choisissez Modifier. Faites les changements dans la boite de dialogue Style et cliquez sur OK
pour sauvegarder ces changements.

Attention La commande Modifier est inactive des lors qu'une ou plusieurs feuilles du
Ja\ classeur sont protégées, méme si le style a modifier n'est appliqué que dans une
/ feuille non protégée.

Gestion des styles

Faites un clic droit sur le nom d'un style dans la fenétre Styles et formatage et cliquez Modifier
pour ouvrir une boite de dialogue Style similaire a celle de la Figure 5.

La boite de dialogue Style a plusieurs onglets. L'onglet Gérer, montré Figure 5 pour les styles de
cellule, est présent dans tous les composants de LibreOffice. Il fournit les informations de base sur
le style. L'onglet Gérer pour les styles de page est identique a celui des styles de cellule.

Style de cellule: Par défaut ==

Gérer |N ombres |Police |E1"Fet5 de caractére |Alignement |Bordures |Arriére-plan Protection de r_ellule|

Marm Par défaut

| =

LCatégorie | |

Contient
Microsoft YaHei + Mangal

OK || Anndler || aide || Reinitialiser | | Standard

Figure 5 : Onglet Gérer de la boite de dialogue Style de cellule

Nom
C'est le nom du style. Vous ne pouvez pas changer le nom d'un style pré-défini, mais vous
pouvez changer le nom d'un style personnalisé.
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Lié a
Cette option est seulement disponible pour les styles de cellule : les styles de page ne peuvent
étre liés. Si vous liez des styles de cellule, alors quand vous modifierez le style de base (par
exemple, en changeant la police de Times a Helvetica), tous les styles liés seront impactés de
la méme fagon. Parfois c'est exactement ce que vous voulez ; d'autres fois vous ne voulez pas
gue les changements s'appliquent a tous les styles liés. Cela mérite réflexion.

Par exemple, vous pouvez construire un nouveau style appelé rouge, dans lequel la seule
modification que vous voulez faire est que le texte de la cellule soit en rouge. Pour vous
assurer gue les autres caractéristiques du texte soient les mémes que le style par défaut, vous
pouvez lier rouge a Par défaut. Ainsi, toute modification que vous ferez a Par défaut
s'appliquera automatiquement a rouge.

Catégorie
Dans Calc, la seule option dans cette liste déroulante est Styles personnalisés.

Options de style de cellule

Quand vous modifiez ou créez des styles de cellules, vous pouvez paramétrer plusieurs options,
qui sont identiques a celles pour formater directement les cellules. Une couverture plus détaillée
du formatage de cellule est effectuée dans le Chapitre 2 (Saisir, Modifier et Formater des
Données). Un bref résumé suit.

Nombres

Dans l'onglet Nombres, vous pouvez contrbler I'affichage des données dans une cellule avec ce
style. Cela comprend la spécification du type de données, le nombre de décimales et la langue.

Police
Utilisez l'onglet Police pour choisir la police du contenu de la cellule.

Effets de caracteres

L'onglet Effets de caractéres propose plus d'options pour la police, comme le soulignage, le barré
et la couleur.

Alignement

Utilisez l'onglet Alignement pour déterminer l'alignement horizontal et vertical des données dans
les cellules, et pour la rotation du texte.

Bordures
Utilisez l'onglet Bordures pour déterminer les bordures pour les cellules, ainsi que le style d'ombre.

Arriére-plan
Utilisez l'onglet Arriére-plan pour choisir la couleur de l'arriére-plan pour une cellule.

Protection de cellule

Utilisez les options de Protection de cellule pour protéger les cellules contre certains types de
moadifications.
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Options de style de page

Plusieurs options de style de page sont décrites plus en détail dans le Chapitre 6 (Imprimer,
Exporter et Envoyer par e-mail), parce que le formatage d'une feuille dans la fenétre principale de
Calc (en utilisant Format > Page), ou lors de I'apercu avant impression (en utilisant Formater la
Page), modifie en fait le style de page.

Page

Utilisez l'onglet Page pour modifier I'apparence générale de la page et sa mise en page. Les
options disponibles sont montrées Figure 6.

Style de page: Par défaut ==

|Gérer |F'age |E>Drdures |Arriére-plan |Er1-téte |F‘ied de page |Feuille|

Format de papier

Largeur 2100cm 3

Hauteur 2970cm =

Orientaticn @ Portrait

Paysage Bac a papier |[D'apré5 les pararmétres dE|'|E||

Marges Parametres de mise en page

Gauche 2,00cm = Mise en page |Dr|:|ite et gauche IE”

Droite 2.00crm = Eormat |1r 23 . |E||

Haut 2 00em = Alignement de la table Herizontal

Bas 2.00cm = Yertical

0K || Annuler || aide || Réinitialiser

Figure 6 : Style de page : onglet Page

Format de papier
Vous pouvez ici déterminer le type de papier générique a utiliser. Lettre ou A4 sont les plus
répandus, mais vous pouvez également utiliser les types de papier Iégal, tabloid, des tailles
d'enveloppes ou définis par l'utilisateur. Vous pouvez également définir I'orientation de la page
et quel bac a papier utiliser (si votre imprimante dispose de plus d'un bac).

Marges
Vous pouvez ici fixer les marges de la page.

Parameétres de mise en page : Mise en page
Vous pouvez spécifier ici si vous voulez appliquer le formatage aux pages de droite (impaires)
uniguement, aux pages de gauche (paires) uniquement, ou a la fois aux pages de droite et de
gauche qui utilisent ce style de page.

Pages en vis-a-vis formate les pages comme si vous vouliez les relier tel un livre.
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La premiére page d'un document est par convention une page impaire.

Parameétres de mise en page : Format
Ce champ détermine le style de numérotation des pages pour ce style de page.

Paramétres de mise en page : Alignement de la table
Cette option permet de centrer les cellules dans une page imprimée, horizontalement ou
verticalement.

Bordures

Les onglets Bordures et Arriere-plan pour les pages sont une copie des onglets de méme nom
pour les styles de cellules et sont surchargés par le style de cellule ou les paramétrages manuels.
Vous pouvez choisir d'ignorer complétement les onglets Bordures et Arriére-plan dans les styles de
page. Les deux onglets disposent d'une zone d'apercu utile pour visualiser le rendu.

Comme pour formater un style de cellule, utilisez I'onglet Bordures pour choisir si la page doit avoir
des bordures, leur largeur, et a quelle distance des bordures le texte doit se trouver.

Arriére-plan

Utilisez cet onglet pour définir I'arriére-plan pour ce style de page. Vous pouvez appliquer une
couleur ou une image en tant qu'arriere-plan.

En-téte

Utilisez cet onglet pour concevoir et appliquer un en-téte pour ce style de page. Pour des
instructions plus détaillées sur la facon de formater un en-téte, voir Chapitre 6 (Imprimer, Exporter
et Envoyer par e-mail).

Pied de page

Utilisez cet onglet pour concevoir et appliquer un pied de page pour ce style de page. Pour des
instructions plus détaillées sur la facon de formater un pied de page, voir Chapitre 6.

Feuille

L'onglet Feuille contient les paramétrages les plus importants pour les styles de page de Calc.
L'onglet Feuille comprend une option qui fixe le premier numéro de page, et la plupart des
paramétrages concernent la fagon dont votre classeur sera imprimé. Voir Chapitre 6.

Créer de nouveaux styles (personnalisés)

Vous pouvez vouloir ajouter de nouveaux styles. Vous avez trois maniéres d'y parvenir :
* Créer un nouveau style en utilisant la boite de dialogue Style
e Créer un nouveau style depuis une sélection
e Créer un nouveau style depuis une cellule avec la souris

Les nouveaux styles s'appliquent uniguement a ce document ; ils ne sont pas
sauvegardés dans le modeéle. Pour sauvegarder les nouveaux styles dans un
modele, voir “Copier et déplacer des styles* page 14 et “Créer un modéle” page
16.

Note
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Créer un nouveau style en utilisant la boite de dialogue Style

Pour créer un nouveau style en utilisant la boite de dialogue Style, faites un clic droit dans la
fenétre Styles et formatage et choisissez Nouveau dans le menu déroulant.

Styles de cellule uniquement : si vous voulez que votre nouveau style soit lié a un style existant,
sélectionnez tout d'abord ce style, puis faites un clic droit et choisissez Nouveau.

Les boites de dialogue et les choix sont les mémes pour définir de nouveaux styles et modifier des
styles existants.

Créer un nouveau style depuis une sélection

Vous pouvez créer un nouveau style de cellule en copiant un format manuel existant.
1) Ouvrez la fenétre Styles et formatage et affichez les styles de cellule.

2) Dans le document, sélectionnez la cellule dont vous voulez enregistrer le formatage en tant
que style.

3) Dans la fenétre Styles et formatage, cliquez sur I'icbne Nouveau style a partir de la
sélection .
4) Dans la boite de dialogue Créer un style, saisissez un hom pour le nouveau style. La liste

affiche les noms des styles personnalisés existants. Cliquez sur OK pour enregistrer le
nouveau style.

Créer un style @
Morm du style [ oK l
MonStyle?|
MenStylel | Annuler |

Figure 7 : Nommer un nouveau style créé depuis une sélection

Créer un nouveau style en faisant glisser la souris

Sélectionnez une cellule (une seule) et faites la glisser dans la fenétre Styles et formatage. Si ce
sont les styles de page qui sont affichés, le "déposer" ne sera pas possible. Gardez alors le clic
gauche enfoncé et amenez le curseur sur le bouton affichant les styles de cellules, puis relachez.

Tous les caractéres sont autorisés dans le nom des styles. De plus, les
différences de casse sont acceptées : vous pouvez définir un style rouge et un
autre style Rouge par exemple. Cependant, un tel cas de figure n'est pas
recommandé, et certaines fonctionnalités peuvent confondre les deux styles.

Note

Créer de nouveaux styles (personnalisés) 13



Copier et déplacer des styles

Pour copier un style depuis un classeur vers un autre, ou entre un classeur et un modéle, au lieu
de le recréer dans le second classeur, utilisez la boite de dialogue Gestion des modéles.

1) Cliquez sur Fichier > Modéles > Gérer.

2) Dans la boite de dialogue Gestion des modeéles (Figure 8), choisissez dans les listes
déroulantes du bas Modéles ou Documents, selon vos besoins. Par défaut, les Modéles
sont a gauche et les Documents a droite.

Pour copier des styles depuis un fichier qui n'est pas ouvert, cliqguez sur le bouton
Astuce Fichier. Quand vous retournez a cette boite de dialogue, la liste affiche a la fois le
fichier sélectionné et les documents déja ouverts.

Gestion des modéles [E3m]
3 Mes modéles [Z] 0304CG3-5tylesAndTemplates [ Fermer ]
(3 Arriére-plans de présentation |=] 0304 CG33FR-5tylesEthModeles
3 en-US |Z| CG3504FR-StylesEtModeles | Commandes |+ |
3 MediaWiki |=| Sans noml

Pré tati
[ Présentations | Aide |

| Carnet d'adresszes... |

|D|:|curr1er1t5 IE" Eichier

Sélectionner Documents comme source de styles
Figure 8 : Choisir de copier des styles depuis un document et non a partir d'un modéle

3) Ouvrez les dossiers et trouvez les modéles ou documents source et cible de votre copie.
Double-cliquez sur le nom du modeéle ou du document, puis double-cliquez sur l'icbne
Styles pour afficher la liste des styles individuels (Figure 9).

4) Pour copier un style, gardez appuyée la touche Ctrl et faites glisser le nom du style d'une
liste a l'autre. Pour déplacer un style, faites glisser le nom sans appuyer la touche Citrl.

5) Répétez l'opération pour chaque style que vous voulez copier. Si le modéle ou document
récepteur a beaucoup de styles, vous pouvez ne pas percevoir de changement jusqu'a ce
que vous fassiez défiler la liste. Quand vous avez terminé, cliquez sur Fermer.
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=| 0304CG3-5tylesfndTemplates |=] 0304CG3-5tylesAndTernplates [ Ferrner l
=| 0304CG33FR-5tylesEtModeles |=] 0304CG33FR-5tylesEtModeles
=| CG3504FR-5StylesEtModeles |=] CG3504FR-5StylesEtModeles | Commandes v|
|=] 5ans noml [=] 5ans neml
E_St_\,rles [=] 5ans nem?2 ;
[0 Par defaut m | Aide |
[y Par defaut (90, Par defaut
[y Rapport [y Par defaut
(A Rouge _— [y Rapport
|=| %ans noma2 -
| Carnet d'adresses... |

Documents IZ” |D|:-cumer1ts IE" | Fichier... |

Figure 9 : Copier un style d'un document vers un autre

Supprimer des styles

Vous ne pouvez supprimer aucun des styles pré-définis de Calc, méme si vous ne les utilisez pas.

Vous pouvez supprimer n'importe quel style défini par un utilisateur (personnalisé) ; mais avant,
vous devriez vous assurer que les styles ne sont pas utilisés. Si un style non désiré est utilisé, il
serait préférable de le remplacer par un style de substitution.

Remplacer des styles (puis supprimer ceux que vous ne voulez pas) peut étre trés utile si vous
gérez un classeur qui a été retravaillé par plusieurs personnes.

Pour supprimer des styles non désirés, faites un clic droit sur ceux-ci (un a la fois) dans la fenétre
Styles et formatage et cliquez sur Supprimer dans le menu contextuel. Choisissez Oui dans la
boite de confirmation.

Créer un classeur depuis un modéle

Pour créer un classeur depuis un modéle :
1) Depuis le menu principal, choisissez Fichier > Nouveau > Modéles et documents. La
boite de dialogue Modéles et documents s'ouvre.

2) Dans la zone de gauche, cliquez sur I'icbne Modeéles si elle n'est pas déja sélectionnée.
Une liste de dossiers et de modéles apparait dans la zone centrale.

3) Double-cliquez sur le dossier qui contient le modéle que vous voulez utiliser. Une liste de
tous les modeles que contient ce dossier apparait dans la zone centrale.
4) Sélectionnez le modéle que vous voulez utiliser. Vous pouvez pré-afficher le modele
sélectionné ou voir les propriétés du modéle :
1) Pour pré-afficher le modéle, cliqguez sur 'icbne Apercu. Un pré-affichage du modéle
apparait dans la zone de droite.

2) Pour voir les propriétés du modéle, cliquez sur l'icobne Propriétés du document. Les
propriétés du modeéle apparaissent dans la zone de droite.
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5) Cliquez sur Ouvrir. La boite de dialogue Modéles et documents se ferme et un nouveau
document basé sur le modéle sélectionné s'ouvre dans Calc.

Modéles et documents - Mes modéles

& @ &

EX3

E)=

[ B

Mouveau
document

=

IModéles

B

Mes documents

Exemples

Obtenir des modéles supplémentaires en ligne...

GErET... | | _Editer

Titre:
calendrier_compact

De:
Thomas Rohmer

m

Date:
01/03/2011, 20:42:28

Modifié par:
Thomas Rohmer

Date de modification:
01/03/2011, 21:09:37

Sujet:

Calendrier perpétuel surl page 44 recto.
Calcule les jours fériés et les changements
d'heure pour différentes zones cu pays: 57

Chuverir

l | Annuler | | Aide

Figure 10 : Boite de dialogue Modeéles et documents

Créer un modeéle

Vous pouvez créer un modeéle a partir d'un document :

1) Ouvrez un document nouveau ou existant du type du modéle que vous voulez obtenir
(document texte, classeur, dessin, présentation).

2) Ajoutez le contenu et les styles que vous voulez.

3) Depuis la barre de menus, choisissez Fichier > Modéles > Enregistrer, ou appuyez sur
Maj+F11. La boite de dialogue Modéles s'ouvre.

4) Dans le champ Nouveau modéle de document, entrez le nom du nouveau modéle.

5) Dans la zone Catégories, cliquez sur la catégorie dans laquelle vous voulez ranger le
modele. La catégorie que vous choisissez n'a aucun effet sur le modeéle lui-méme ; c'est
simplement le dossier dans lequel vous enregistrez le modéle. Si vous choisissez un
dossier (catégorie) significatif, il sera plus facile de retrouver un modéle quand vous en
aurez besoin. Vous pouvez avoir besoin de créer un dossier pour les modéles Calc.

Pour plus de détails sur les dossiers de modeles, voir “Organiser les modéles” page 21.
6) Cliquez sur OK pour enregistrer le nouveau modele.
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Modéles ==

Mouveau modéle de document

| Annuler |
Modeles
Catégories Modéles | Aide |
:
Arrigre-plans de présentation | Editer |
en-Us
MediaWiki | Gerer.. |

Prézentations

Figure 11 : Enregistrer un nouveau modéle

Tous les parameétres qui peuvent étre ajoutés ou modifiés dans un document peuvent étre
enregistrés dans un modeéle. Par exemple, voici quelques paramétrages (ce n'est pas une liste
complete) qui peuvent étre compris dans un document Calc et ensuite enregistrés dans un modele
pour une utilisation ultérieure :

* Paramétrages de l'impression : quelle imprimante, impression recto-verso, taille du papier,
etc.

* Styles de cellules et de pages a utiliser

Les modeles peuvent également contenir des textes et des formules pré-définis, ce qui vous évite
d'avoir a les retaper chaque fois que vous créez un nouveau document. Par exemple, un modéle
de facture pourrait contenir le nom, l'adresse et le logo de votre société.

Vous pouvez également enregistrer la personnalisation des menus et des barres d'outils dans des
modéles ; voir Chapitre 14 (Paramétrer et Personnaliser Calc) pour plus d'informations.

Modifier un modele

Vous pouvez modifier les styles et contenus d'un modéle et ensuite, si vous le souhaitez, vous
pouvez ré-appliquer les styles du modéle aux documents créés a partir de ce modele. (Notez que
vous ne pouvez ré-appliquer que les styles uniquement. Vous ne pouvez pas ré-appliquer le
contenu.)

Pour modifier un modéle :
1) Depuis le menu principal, choisissez Fichier > Modéles > Gérer. La boite de dialogue
Gestion des modéles s'ouvre.

2) Dans la zone de gauche, double-cliquez sur le dossier qui contient le modéle que vous
voulez modifier. Une liste de tous les modeles contenus dans ce dossier apparait sous le
nom du dossier.

3) Sélectionnez le modele que vous voulez modifier.
4) Cliquez sur le bouton Commandes et choisissez Editer dans la liste déroulante.

5) Modifiez le modéle comme vous le feriez pour un autre document. Pour enregistrer vos
changements, choisissez Fichier > Enregistrer dans la barre de menus.
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Figure 12 : Boite de dialogue Gestion des modéles

Mettre a jour un classeur depuis un modeéle modifié

La fois suivante ou vous ouvrirez un classeur qui a été créé avec le modéle que vous venez de
modifier, le message suivant apparaitra :

LibreOffice 3.6 [E3m]

6 Le modéle 'Ex_Modl' sur lequel le document est basé, a été modifié, Voulez-vous

actualiser le formatage basé sur les styles en fonction du modéle modifie ?

[ Actualiser les styles! l ’ Conserver les anciens styles ] ’ Aide ]

Figure 13 : Message de mise a jour des styles

Cliquez sur Actualiser les styles pour appliquer les styles modifiés dans le modéle au classeur.
Cliquez sur Conserver les anciens styles si vous ne voulez pas appliquer les styles modifiés
dans le modéle au classeur (mais voyez la note Attention ci-dessous).

Si vous choisissez Conserver les anciens styles dans la boite de message de la
Attention Figure 13, ce message ne réapparaitra pas la prochaine fois que vous ouvrirez le
A\ document aprés avoir modifié le modeéle sur lequel il est basé. Vous n'aurez pas
/ d'autre chance de mettre a jour les styles depuis le modele, a moins que vous
n'utilisiez la macro dans la Note ci-dessous pour réactiver cette fonctionnalité.
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Note

Pour réactiver la mise a jour depuis un modéle :

1) Utilisez Outils > Macros > Gérer les macros > LibreOffice Basic.
Sélectionnez le document dans la liste, cliquez sur le symbole d'expansion (+ ou
triangle), et sélectionnez Standard. Si Standard est précédé par un symbole
d'expansion, cliquez sur lui et sélectionnez un module.

2) Sile bouton Editer est actif, cliquez sur lui. Si le bouton Editer n'est pas actif,
cliguez sur Nouveau.

3) Dans la fenétre Basic, saisissez :

Sub FixDocV3

activer UpdateFromTemplate

oDocSettings = ThisComponent.createInstance( _
"com.sun.star.document.Settings" )
oDocSettings.UpdateFromTemplate = True

End Sub 'FixDocV3

4) Cliquez sur l'icbne Exécuter le BASIC (F5), puis fermez la fenétre Basic.
5) Enregistrez le document.

La fois suivante ou vous ouvrirez ce document, la fonctionnalité de mise a jour a
partir du modéle sera de retour.

Ajouter des modeles en utilisant le Gestionnaire des

extensions

Le Gestionnaire des extensions fournit une maniére facile d'installer des ensembles de modéles,
de graphiques, de macros et d'autres modules externes qui ont été archivés dans des fichiers avec
une extension .OXT. Voir Chapitre 14 (Paramétrer et Personnaliser Calc) pour plus d'informations
sur le Gestionnaire des extensions.

Cette page web regroupe beaucoup d'extensions disponibles : http://extensions.libreoffice.org/.

Pour installer une extension, suivez ces étapes :
1) Téléchargez un package d'extensions et enregistrez-le ou vous voulez sur votre ordinateur.
2) Dans LibreOffice, choisissez Outils > Gestionnaire des extensions dans la barre de
menus. Dans la boite de dialogue Gestionnaire des extensions, cliquez sur Ajouter.

3) Une fenétre d'exploration des fichiers s'ouvre. Trouvez et sélectionnez le package de
modéles que vous voulez installer et cliquez sur Ouvrir. Le package commence a
s'installer. 1l est possible que vous ayez a accepter un contrat de licence.

4) Quand l'installation du package est terminée, les modéles sont disponibles dans Fichier >
Nouveau > Modéles et documents et I'extension apparait dans le Gestionnaire des
extensions.
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Figure 14 : Extension nouvellement ajoutée

Définir un modéle par défaut

Si vous créez un document en choisissant Fichier > Nouveau > Classeur dans la barre de
menus, LibreOffice crée un document a partir du modéle Par défaut pour les classeurs. Vous
pouvez cependant définir un modele personnalisé en tant que modéle par défaut. Vous pourrez
réinitialiser le modele par défaut plus tard si vous le souhaitez.

Définir un modeéle personnalisé en tant que modéle par défaut

Vous pouvez définir tout modéle en tant que modeéle par défaut, a partir du moment ou il appartient
a l'un des dossiers affichés dans la boite de dialogue Gestion des modéles.
Pour définir un modéle personnalisé en tant que modele par défaut :

1) Dans la barre de menus, choisissez Fichier > Modéles > Gérer. La boite de dialogue
Gestion des modeles s'ouvre.

2) Dans le champ a gauche, sélectionnez le dossier qui contient le modéle que vous désirez,
puis sélectionnez le modéle.

3) Cliquez sur le bouton Commandes et choisissez Définir comme modéle par défaut dans
la liste déroulante.

La fois suivante ol vous créerez un document en choisissant Fichier > Nouveau, le document
sera créé selon ce modele.
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Réinitialiser le modeéle par défaut

Pour redéfinir le modeéle de classeur par défaut de LibreOffice en tant que modele par défaut :

1) Dans la boite de dialogue Gestion des modeéles, cliquez sur n'importe quel dossier dans le
champ a gauche.

2) Cliquez sur le bouton Commandes et choisissez Rétablir le modéle par défaut >
Classeur dans la liste déroulante.

La fois suivante oU vous créerez un classeur en choisissant Fichier > Nouveau, il sera créé selon
le modéle de classeur par défaut de LibreOffice.

Associer un classeur a un modele différent

Vous pouvez vouloir ultérieurement associer un classeur a un modéle différent, ou peut-étre vous
travaillez sur un classeur qui n'est pas issu d'un modéle, mais vous voulez l'associer désormais a
un modéle.

Un des avantages majeurs de l'utilisation des modéles est la facilité de mise a jour des styles dans
plus d'un document, comme indiqué page 18. Si vous mettez a jour les styles en les copiant d'un
modéle différent (comme indiqué page 14), le document n'a pas d'association avec le modéle
depuis lequel les styles ont été chargés ; de fait, vous ne pouvez pas utiliser cette méthode. Ce
dont vous avez besoin est d'associer le document a un modéle différent.

Pour de meilleurs résultats, les noms des styles devraient étre les mémes dans le document
existant et le nouveau modéle. S'ils ne le sont pas, vous devrez utiliser Rechercher & remplacer
pour remplacer les anciens styles par les nouveaux. Voir Chapitre 2 (Entrer, Modifier et Formater
des Données) pour de plus amples informations sur le remplacement des styles en utilisant
Rechercher & remplacer.

1) Utilisez Fichier > Nouveau > Modéles et documents. Choisissez votre modeéle. Un
nouveau fichier, basé sur le modéle, s'ouvre. Si le modele contient des textes ou des
graphiques non désirés, supprimez les.

2) Ouvrez le classeur que vous voulez modifier. (Une nouvelle fenétre est ouverte.) Appuyez
Ctrl+A pour tout sélectionner dans le classeur, puis copiez le résultat dans le presse-
papiers.

3) Basculez dans la fenétre qui contient le classeur vide créé a I'étape 1 et collez le contenu
dans ce classeur.

4) Répétez les étapes 2 et 3 pour chaque feuille du classeur.

5) Enregistrez le fichier sous un nouveau nom.

Organiser les modéles

LibreOffice ne peut utiliser que les modéles qui se trouvent dans les dossiers de modéles (voir
l'astuce ci-dessous). Vous pouvez créer de nouveaux dossiers de modeles et les utiliser pour
organiser vos modéles, et importer des modeles dans ces dossiers. Par exemple, vous pourriez
avoir un dossier pour les modéles de classeurs et un autre pour les modéles de lettres. Vous
pouvez également exporter les modéles.

Pour commencer, choisissez Fichier > Modeles > Gérer dans la barre de menus. La boite de
dialogue Gestion des modéles s'ouvre.
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Toutes les actions faites par le bouton Commandes dans la boite de dialogue
Note Gestion des modéles peuvent étre également effectuées par un clic droit sur les
modeles ou les dossiers.

L'emplacement des dossiers de modéle LibreOffice varie en fonction du systéeme
Astuce d'exploitation de votre ordinateur. Pour savoir ou sont stockés les dossiers de
modéles, allez sous Outils > Options > LibreOffice > Chemins.

Tout document (texte, classeur, dessin, diaporama) peut servir de modele, quel
Astuce gue soit son emplacement : depuis l'explorateur de fichiers du systéme, faites un
clic droit sur le document puis choisissez Nouveau.

Créer un dossier de modeéles
Pour créer un dossier de modeles :

1) Dans la boite de dialogue Gestion des modeéles, cliquez sur n'importe quel dossier.

2) Cliquez sur le bouton Commandes et choisissez Nouveau dans le menu déroulant. Un
nouveau dossier intitulé Sans nom apparait.

3) Saisissez un nom pour le nouveau dossier et appuyez sur Entrée. LibreOffice enregistre le
dossier avec le nom que vous avez saisi.

Supprimer un dossier de modéles

Vous ne pouvez pas supprimer les dossiers fournis avec LibreOffice ou installés en utilisant le
Gestionnaire des extensions ; vous ne pouvez supprimer que les dossiers que vous avez créés.

Pour supprimer un dossier de modéles :
1) Dans la boite de dialogue Gestion des modéles, sélectionnez le dossier que vous voulez
supprimer.

2) Cliquez sur le bouton Commandes et choisissez Supprimer dans le menu déroulant. Une
boite de message apparait et vous demande de confirmer la suppression. Cliquez sur Oui.

Déplacer un modeéle

Pour déplacer un modéle d'un dossier de modéles a un autre :

1) Dans la boite de dialogue Gestion des modéles, double-cliquez sur le dossier qui contient
le modéle que vous voulez déplacer. La liste des modéles contenus dans ce dossier
apparait en-dessous de son nom.

2) Cliquez sur le modeéle que vous voulez déplacer et faites le glisser sur le dossier voulu. Si
Vous n'avez pas l'autorisation de supprimer des modéles dans le dossier source, cette
action copie le modele au lieu de le déplacer.
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Supprimer un modele

Vous ne pouvez pas supprimer les modéles fournis avec LibreOffice ou installés en utilisant le
Gestionnaire des extensions ; vous ne pouvez supprimer que les modéles que vous avez créés ou
importés.

Pour supprimer un modele :

1) Dans la boite de dialogue Gestion des modéles, double-cliquez sur le dossier qui contient
le modele que vous voulez supprimer.

2) Cliquez sur le modeéle que vous voulez supprimer.

3) Cliquez sur le bouton Commandes et choisissez Supprimer dans le menu déroulant. Une
boite de message apparait et vous demande de confirmer la suppression. Cliquez sur Oui.

Importer un modéle

Si un modéle que vous voulez utiliser se trouve a un endroit différent, vous pouvez l'importer dans
un dossier de modeles LibreOffice.

Pour importer un modéle dans un dossier de modéles :

1) Dans la boite de dialogue Gestion des modéles, sélectionnez le dossier dans lequel vous
voulez importer le modele.

2) Cliquez sur le bouton Commandes et choisissez Importer un modéle dans le menu
déroulant. Une fenétre standard d'exploration des fichiers s'ouvre.

3) Trouvez et sélectionnez le modéle que vous voulez importer et cliquez sur Ouvrir. La
fenétre d'exploration des fichiers se referme et le modéle apparait dans le dossier
sélectionné.

4) Sivous le souhaitez, saisissez un nouveau nom pour le modéle et appuyez sur Entrée.

Exporter un modele

Pour exporter un modéle d'un dossier de modéles vers un autre emplacement :

1) Dans la boite de dialogue Gestion des modéles, double-cliquez sur le dossier qui contient
le modéle que vous voulez exporter.

2) Cliquez sur le modeéle que vous voulez exporter.

3) Cliquez sur le bouton Commandes et choisissez Exporter un modéle dans le menu
déroulant. Une fenétre Enregistrer sous s'ouvre.

4) Trouvez le dossier dans lequel vous voulez exporter le modéle et cliquez sur Enregistrer.
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